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SHORT ABSTRACT: 
[bookmark: OLE_LINK7][bookmark: OLE_LINK8]This protocol describes the fabrication of a small, ready-to-use cassette that can be applied for visual detection of multiple nucleic acids in a single, test that is easy to operate. In this approach, a capillary array was used for multiplex and highly efficient detection of GMO targets.

LONG ABSTRACT: 
[bookmark: OLE_LINK14][bookmark: OLE_LINK15]Multi-target, short time, and resource-affordable methodologies for the detection of multiple nucleic acids in a single, easy to operate test are urgently needed in disease diagnosis, microbial monitoring, genetically modified organism (GMO) detection, and forensic analysis. We have previously described the platform called CALM (Capillary Array-based Loop-mediated isothermal amplification for Multiplex visual detection of nucleic acids). Herein, we describe improved fabrication and performance processes for this platform. Here, we apply a small, ready-to-use cassette assembled by capillary array for multiplex visual detection of nucleic acids. The capillary array is pre-treated into a hydrophobic and hydrophilic pattern before fixing loop-mediated isothermal amplification (LAMP) primer sets in capillaries. After assembly of the loading adaptor, LAMP reaction mixture is loaded and isolated into each capillary, due to capillary force by a single pipetting step. The LAMP reactions are performed in parallel in the capillaries. The results are visually read out by illumination with a hand-held UV flashlight. Using this platform, we demonstrate monitoring of 8 frequently appearing elements and genes in GMO samples with high specificity and sensitivity. In summary, the platform described herein is intended to facilitate the detection of multiple nucleic acids. We believe it will be widely applicable in fields where high-throughput nucleic acid analysis is required.

INTRODUCTION: 
[bookmark: OLE_LINK31][bookmark: OLE_LINK21][bookmark: OLE_LINK24][bookmark: OLE_LINK29][bookmark: OLE_LINK30][bookmark: OLE_LINK38][bookmark: OLE_LINK54]Low-cost, quick, and easy to use systems for the simultaneous detection of multiple nucleic acids are urgently needed in a wide range of fields, such as clinical diagnostics1-3, GMO detection4-6, microbial monitoring7-9, forensic analysis10,11, and especially point-of-care tests (POCTs), where resources are usually limited12-14.

[bookmark: OLE_LINK39][bookmark: OLE_LINK62]Polymerase chain reaction (PCR), including its derivative methods real-time PCR and multiplex PCR, is the most widely applied technique for detection in these fields. However, these methods typically only detect one target in one test15 and they require electricity and sophisticated professional equipment.

Another promising technology for detecting nucleic acids is Loop-mediated isothermal amplification (LAMP), which was first described in 200016. LAMP is a high efficiency DNA detection method. Theoretically, it can amplify from 1 copy to 109 copies of amplicons within one hour, all performed at a constant temperature, (i.e., between 60–65 °C). Successful amplification will produce a large amount of the insoluble byproduct pyrophosphate and cause a change in turbidity17, which could be directly observed by the naked eye. A color change can also be observed by the addition of metal ions or fluorescent dyes such as Calcein18, Nucleic acid dye19, and hydroxyl naphthol blue20. Because of the advantages of high sensitivity and convenience of operation, LAMP is being widely applied in nucleic acid detection.

Currently, there are mainly two strategies for multiplex LAMP assays. One is to perform multiple LAMP assays by having multiple LAMP primer sets in one tube21-23. However, the multiplicity and the amplification efficiency would be limited by the intrinsic interference and competition among different primer sets. Furthermore, it can be difficult to identify different LAMP products in the same reaction. Another strategy is based on physical isolation. Different primer sets were isolated into individual miniaturized compartments, and multiple LAMP reactions are then performed simultaneously24,25. These approaches, which are generally based on microfluidic chips, provide a potential solution for high-throughput LAMP reactions. However, the manufacture of the chips and the multiplex pre-coating of primer sets is complicated, which may increase costs and decrease reproducibility.

Recently, a few studies have described performing LAMP reactions in capillaries to bypass the complicated fabrication of microfluidic chips and have achieved low-cost detection26,27. However, with regards to high-throughput analysis, these capillaries are similar to miniature versions of PCR strip tubes, because the samples and reaction reagents (including the different primer sets) must be individually prepared and delivered to different reaction units within capillaries. To achieve parallel and multiplex analysis, additional equipment, for example a multichannel syringe pump, is required for parallel loading of samples or reagents. 

To overcome the limitations associated with the current methods for multiplex detection of nucleic acids, we have developed a miniaturized platform which combines visual LAMP technology with a capillary array. This platform is multi-target, compact in size, low cost, and easy to operate28. Herein, we describe the details of how to fabricate the capillary array and perform the LAMP reactions in the array. The protocol described here has been standardized using genetically modified organism (GMO) detection as a model. Importantly, this protocol can also be used in high-throughput detection of other nucleic acid targets.

PROTOCOL: 

Note: This protocol assumes that the stainless steel mold bearing the shape for the desired micro-channels and the loading adaptor have already been made (3D files are provided as Supplemental Files 1 and 2). This protocol also assumes that plant DNA isolation has already been carried out.

1. Fabrication of the Capillary Array-based Ready-To-Use Cassette

1.1. Clean the stainless-steel mold.

1.1.1. Wash the stainless-steel mold by detergent, ethanol, and deionized water to remove the potential contaminants. Dry the mold by nitrogen.

1.2. Clean the capillaries

1.2.1. Wear safety goggles, acid and alkali-resistant rubber uniforms, and chemical protective gloves. 

[bookmark: OLE_LINK9][bookmark: OLE_LINK10][bookmark: OLE_LINK17][bookmark: OLE_LINK18]1.2.2. Place capillaries into an acid cylinder. Clean the capillaries with 30 mL acetone for 5 min to remove organic matter, and then wash the capillaries with deionized water. 

Caution: Handle acetone in a fume hood.

[bookmark: OLE_LINK13][bookmark: OLE_LINK16]1.2.3. Pour 10 mL of H2O2 into the acid cylinder and then add 30 mL of H2SO4 into the H2O2 with slow shaking to prevent overheating. Make sure that the solution (piranha solution) completely covers the capillaries for at least 30 min.

Caution: Be careful while handling piranha solution (H2SO4/H2O2 = 3: 1, v/v). If the piranha solution is spilled, wash away the solution quickly with a large amount of water and wipe the surface with paper towels.

Note: Thorough cleaning of capillaries is one of the key points to ensure the success of the LAMP reaction. It is necessary to shake the acid cylinder during the cleaning process to remove the bubbles in capillaries, and the clean time can also be extended when required.

1.2.4. Wash away the piranha solution with a large amount of water. Wash capillaries with ethanol and deionized water for 5 min each. Dry the capillaries in a drying oven.
[bookmark: OLE_LINK5][bookmark: OLE_LINK6]
1.3. Pour polydimethylsiloxane (PDMS)

[bookmark: OLE_LINK19][bookmark: OLE_LINK20]1.3.1. Weight out PDMS base and curing reagents with a ratio of 1:1 in a beaker. Typically, mix 5 g of elastomer base to 5 g of elastomer curing agent.

1.3.2. Stir the mixture thoroughly for about 5 min with a glass rod. Place the beaker with PDMS in a vacuum bell jar for 30 min for de-gassing.

[bookmark: OLE_LINK22][bookmark: OLE_LINK23]1.3.3. Pour the PDMS slowly into the cylinder of the stainless-steel mold. Allow the PDMS to cure for 3 h in a drying oven at 60 °C

Note: Be careful to avoid air bubbles when pouring PDMS. After pouring PDMS, allow it stand for 5 min for natural removal of bubbles out of PDMS.

1.4. Remove the mold from PDMS

1.4.1. After curing the PDMS, remove the mold by pulling out the mold with cylinder. Remove PDMS from the cylinder by cutting the margin of mold with a scalpel.

1.4.2. Wash PDMS three times with ethanol and deionized water. Dry the PDMS support with nitrogen.

[bookmark: OLE_LINK1][bookmark: OLE_LINK4]1.5. Treat the lower surface of the PDMS support to be hydrophobic. Soak the PDMS support in a super-hydrophobic coat for 1 s. Dry it for 10 min at room temperature.

1.6. Insert the capillary into the PDMS support

1.6.1. Insert the cleaned 4 mm capillaries into the holes of the PDMS support and leave 0.5 mm of the capillaries outside the top surface of the PDMS support. Make sure the ends of capillaries are on the same level.

1.7. Treat the outer surface of the capillaries and the top surface of the PDMS support to be hydrophobic.

[bookmark: OLE_LINK36][bookmark: OLE_LINK37]1.7.1. Add 15 μL super-hydrophobic coat onto the top surface of the PDMS support. Note that the coating immediately spreads all over the top surface (including the top surface of the PDMS support and the outer surfaces of the exposed part of the capillaries) by capillary force. 

1.7.2. Air dry the super-hydrophobic modified capillary array.

1.8. Fix primer into capillary array

1.8.1. Prepare primer solution. Weight out 0.65 g chitosan (molecular formula: (C6H11NO4)n) and dissolve it into 50 mL deionized water by adjusting the pH to 4.5-5.5 with acetic acid to achieve a chitosan concentration of 1.3%. Prepare primer components mix as per Table 1. See Supplementary Table 1 for primers

[Place Table 1 here]

1.8.2. Add 1.6 μL of the mixture of one set of primers to fill one corresponding capillary of the capillary array according to a pre-designed order.

Note: The remaining two blank capillaries were set as negative controls.

1.8.3. Anchor the array in a transparent well of a standard flat bottom 96-well plate and dry the array at 60 °C for at least 2 h.

1.9. Assemble the cassette as follows. Put a loading adaptor onto the top of anchored array. Make sure the dish of the adaptor just covers the exposed parts of all ten capillaries (See Figure 1).

[Place Figure 1 here]

2. Performance of LAMP Reaction in Capillary Array

2.1. Prepare the reaction mix

2.1.1. Prepare the LAMP reaction mix as per Table 2.

[Place Table 2 here]

2.1.2. Add reagents to mixture according to the chosen order, as in Table 2, and vortex the reaction mixture for 5 s after adding calcein. Gently invert the tube 20 times after Bst polymerase is added.

2.2. Load the reagents and seal the cassette 

2.2.1. Pipette 20 μL LAMP reaction mixture with a standard 100-μL tip. Insert the tip into the inlet of the loading adaptor to lock it. Gently inject the reaction mixture into the dish of adaptor; the reaction mixture will quickly fill the dish and then load the capillaries automatically through capillary force. 

2.2.2. Remove the adaptor with the locked tip and seal the well by a PCR-compatible transparent sealing film.  

Note: Only the capillaries touching the reaction mixture in the hydrophilic dish could be filled. So make sure the top side of all the capillaries are of the same height (See Figure 2).

[Place Figure 2 here]

2.3. Incubate the capillary array in an incubator at 63 °C for 1 h.

3. Results Readout and Data Analysis

3.1. Acquire images of the fluorescence emission.

3.1.1. Fix a UV filter on the top surface of a small hand-held UV LED flashlight to filter the visible light. 

3.1.2. Excite the dissociated calcein to emit fluorescence with the UV flashlight. Capture images from the top of the capillary array by either a digital camera or a smartphone. 

3.1.3. When taking an image, ensure that the camera is zoomed in on the area of the capillaries as much as possible to get high quality, clear images.

3.2. Analyze the results

3.2.1. Open the image by image analysis software and then select “Image>Mold>Grayscale>Yes” and “Image>Mold>16bit>Yes”. Select “File>Save as>format>TIFF” to convert the image to 16-bit TIFF format. 

3.2.2. Extract the value of fluorescence intensity

3.2.2.1. Open the microarray analysis software. Drag the 16-bit TIFF format image into the interface of the software and then select the wavelength of “532nm” and a color of “green” to display the image. 

3.2.2.2. Create a new block to locate the fluorescence signal from the capillaries. Select “Tools>New blocks” and input the number of columns and rows as “1;1” and “2;5” in the ‘blocks’ and ‘features’ interfaces separately. 

3.2.2.3. Right click and select “Features” model and then adjust the location and diameter to fit the fluorescence area of capillaries. Select “Analyze” to extract the value of fluorescence intensity. 

3.2.2.4. Select “File>save settings as” to save the blocks documents and select “File>save results as” to save the fluorescence intensity results. Calculate the SNR to define whether LAMP is successfully performed in the capillaries.

Note: Signals of the capillaries were obtained by recording the gray values of the spots and signal to noise ratios (SNRs) were defined as ratios of mean values of foreground signals of the targets to average mean values of foreground signals of the two negative controls. The cutoff to determine positive signals was set as SNR >2. 

REPRESENTATIVE RESULTS: 
In this method, it is important to prevent cross-contamination among different capillaries during the sample loading. For this purpose, chitosan was introduced, which could retain the primers in individual capillaries. To test whether it worked or not, we pre-fixed the ADH1 (endogenous reference gene of maize) primer set in the capillary cassette with the pattern of “T” and “U”, as illustrated in Figure 3a. As expected, only the capillaries contained primer sets showing positive signals (Figure 3b).

[Place Figure 3 here]

To further evaluate the ability to monitor GMO, we chose seven frequently-used transgenic
elements which cover ~75% of the commercialized GMO events (i.e., P-CaMV35S, bar, cp4 epsps, P-FMV35S, pat, T-nos and nptII) (Figure 4, layout) which correspond to the capillaries number 1-7, and one endogenous reference gene for maize (ADH1). To show the specificity of this method, three GM events (MON863, MON89034, and 59122) were selected and applied to CALM. To analyze the results, fluorescence images were taken by camera and analyzed as described in the protocol steps. Expected results were obtained for all the tests (Figure 4). For example, for the GM maize MON863, positive signals were obtained for capillaries 1, 6, 7, and 8, which correspond to targets P-CaMV35S, T-nos, nptII, and the endogenous reference gene ADH1, respectively.

[Place Figure 4 here]

To test the performance of our method in a real world application, two practical maize samples were selected for analysis by CALM. Then the results were compared with that of real-time PCR and results were consistent (Figure 5, Supplementary Table 2) 

[Place Figure 5 here]

FIGURE LEGENDS:

Figure 1: The cassette fabrication and assembly. (a) Stainless mold and the PDMS support. The mold consists of 3 parts: cylinder, dam board, and pillar plate. (b) The schematic of PDMS support fabrication and assembly of the capillary cassette. The whole process contains 5 steps: 1. PDMS pouring, 2. Mold removing, 3. Capillary inserting and surface coating, 4. primer fixing and 5. cassette anchoring. 1. Pour PDMS into cylinder of the mold; 2. Push out the dam board to remove the mold from PDMS support; 3. Coat the down surface of PDMS support and then insert the capillaries into the PDMS support, lastly coat the upper surface of PDMS support and exposed capillaries. The thick blue line indicates super-hydrophobic coat; 4. Load primer set into individual capillaries; 5. Anchor the capillary array in a single 96-well plate and install a sample loading adaptor onto it. The details have been described in protocol steps 1.1-1.9.

Figure 2: Diagram of sample-loading using the loading adaptor. The picture shows the loading process employing blue solution as an example. Insert the tip into the inlet and inject the sample into the adaptor slowly, and then remove the adaptor with locked tip.

Figure 3: Examples of capillary result. (a) The layout of the capillary array. The green spots indicate that ADH-1 primer sets are pre-fixed in capillaries. (b) Fluorescent photographs of the two capillary arrays after LAMP. The green color presented the positive LAMP amplification. The test was performed in duplicate. Successful amplification only presented in primer-fixed capillaries and without contamination among blank capillaries. 

Figure 4: The specificity for monitoring GMOs. The detection of different DNA samples, i.e., MON863, MON89034, 59122, mix of all the above three GM events (GMO mix), Non-GM maize and pure water (no template control, NTC). 1–8: Capillaries pre-fixed with LAMP primer sets of P-CaMV35S, bar, cp4 epsps, P-FMV35S, pat, T-nos, nptII, and ADH-1, individually. 9–10, two no-primer controls. The test was performed in duplicate and we found that all the results were consistent with expectations. See Supplementary Table 2 for data analysis

Figure 5: The results of testing two maize samples. 1–8: Capillaries pre-fixed with the LAMP primer set of P-CaMV35S, bar, cp4 epsps, P-FMV35S, pat, T-nos, nptII, and ADH-1, individually. 9–10, two no-primer controls. The test was performed in duplicate and then the results were compared with that of real-time PCR and the results were consistent. See Supplementary Table 3 for comparison results. See Supplementary Table 2 for data analysis.

Table 1: The components of LAMP primer fixing reagents. The components of LAMP primer fixing mix are listed in the left column of the table, and the volume of each component is listed in the right column.

Table 2: The reaction system of the capillary array-LAMP. The components of the reaction system of capillary array LAMP components are listed in left column, and the volume of each component is listed in the right column.

Supplementary Table 1: List of LAMP primer sequences.

Supplementary Table 2: Data analysis of the LAMP array experiments. The green color coded cells in the table indicate the positive result

Supplementary Table 3: The real-time PCR results reporting form.

DISCUSSION: 
The CALM platform demonstrated here, which combines the LAMP technology with a capillary array, enables the simultaneous detection of multiple GMO-related gene targets in a single, highly effective and easy to operate test.

To successfully perform the multiplex LAMP reactions in the cassette, three critical points need to be noticed. Firstly, achieving the same height for the upper side of the capillaries and the hydrophilic and hydrophobic pattern of the capillary array are critical for simultaneously loading reagents into all the capillaries. The capillaries should be aligned by a plate after initial inserting into the PDMS support to ensure all of them can touch the loaded reaction mixture in the dish of the loading adaptor. When treating the capillary array with the super-hydrophobic coat, do not allow the coat to soak into the inner surface of the capillaries. Treat the outer surface of the capillaries by just loading coat on the top surface of the top PDMS support, allowing the coating to spread to the outer surfaces of the upper parts of the capillaries. If it occasionally happens that not all the capillaries are filled with the reagents, it may be prudent to load reagent directly into a specific capillary.

Secondly, be careful with the preparation of LAMP reagents. The whole process should be gently and quickly carried out on ice, due to the relatively low reaction temperature of LAMP and the fragility of the Bst polymerase. It’s advisable to shake the reaction tube with the LAMP mixture gently instead of vortexing the tube violently after adding Bst polymerase. An inappropriate handling may cause failure of the reaction. In this experiment, ADH1(endogenous reference gene of Maize) is set as the positive control and two capillaries without primers are set as blank controls. So, if LAMP mixture is correctly handled, the positive control would show green and the blank control would remain unchanged after the test is performed.

Thirdly, due to the high efficiency of the LAMP reaction, false positive or carryover contamination may happen if there is a trace amount of DNA amplicon in the environment. Therefore, always bear in mind that the operating processes of pre-reaction and post-reaction should be strictly separated in different areas and the LAMP products should be tightly sealed and discarded after analysis. Furthermore, a blank control should be set for indicating an adequate performance of the LAMP.

Intrinsically, CALM is a universal multi-target nucleic acid detection method with good flexibility and expandability. LAMP reactions performed in capillaries can be easily substituted by other types of isothermal amplification methods, such as rolling circle amplification (RCA)29, and recombinase polymerase amplification (RPA)30. It can also be applied in other detection fields, such as pathogen detection27 and disease diagnosis31. 

In the current form of this method, although primer sets are pre-fixed with chitosan, the process of LAMP mixture preparation is still needed when the test is performed, which lowers the simplicity of the method. To address this, we would try to preload all the reagents of LAMP in the capillary and then pipette the sample into the cassette. Another limitation for our method may be the lack of nucleic acid extraction, but we are now developing a mobile-based machine which would combine the extraction of nucleic acids, automatic image taking, and data analysis to achieve a real “sample-in and results-out” method. 

In summary, we have developed the CALM platform by integrating multiplex LAMP with a capillary array. As a general nucleic acid detection method, CALM may also have potential in a wide range of other nucleic acid analysis applications.
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